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1. GENERAL DESCRIPTION

The polarographic measurements of dissolved oxygen by a Clark electrode is the primary
application. The OxyCorder provides an adjustable polarizing voltage (-1 to +1V; -0.7V for
oxygen) to the electrode and measures the electric current with a high accuracy and stability.
Three input channels are adapted for different electrode types including a bare electrode for
fast measurements. The signal is digitized and transferred via a serial port to a computer.
The software displays the measured curves on the computer screen and helps to evaluate the
rates of oxygen concentration changes. The programmable auxiliary TTL outputs are
designed to control external light sources as LED panels, shutters or flash lamps in synchrony

with a user-defined measuring protocol.

As the OxyCorder serves primarily to facilitate the polarographic measurements of dissolved
oxygen in photosynthesis research, impedance of 3 independent electrode input channels is
pre-set for various electrode sizes: 4 MQ (channel 1), 1.3 MQ (channel 2), and 33 kQ
(channel 3 - for large electrodes as bare platinum-silver). The fourth input channel enables a
voltage reading (+ 200 mV, e.g., fluorescence signal from a fluorometer). The PC OxyWin
software controls polarization voltage of the electrodes (0 to 1000 mV, two 10 bit D/A
converrtors), other parameters and features of the instrument, and displays and analyses the

data.

Any of the 3 input channels may be configured for a voltage reading (maximally 10
measurements per second in one channel mode) and the instrument can be also used to
replace chart recorders. Three TTL outputs (minimal timing step is 1 ms) allow controlling
external devices as shutters or flash lamps. The reading of data can be synchronized with the
controlling signals. For example, the oxygen bursts occurring in the organisms of oxygenic
photosynthesis after an exposure to actinic flashes can be measured with a pre-set delay

between the flash and the measurement.

Free software upgrades can be downloaded from our homepage (http://www.psi.cz). The homepage also offers
mailing and E-mail addresses for inquiries and technical support as well as for pricing information and

information on our newest products.
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2. CONFIGURATION OF YOUR INSTRUMENT

pc | Item

OxyCorder 3018 control unit

Serial port cable

2-pin BNC plug

220V AC/7-19V DC power adapter
Installation diskette

User’s Guide
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3. HARDWARE ASSEMBLY

Front and back panels of the OxyCorder control unit are shown in Fig. 1 and Fig. 2,

respectively.

Fig.1. - Front panel of the OxyCorder control unit. Three input channels for electrodes with impedance 4M(2
(1), 1.3 M2 (2), and 33 k€2 (3) and one input channel for voltage reading (+ 200 mV) (4). Three TTL outputs for

controlling of external devices (5, 6, 7).

Fig.2. - Back panel of the OxyCorder control unit. Switch On / Off button (1), the plug for the serial port cable
(2) and the plug for the AC/DC power adapter (3).
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To assemble the instrument, follow the steps below:

a)

b)

d)

g)

h)

Check if the delivered components match the configuration of your instrument printed

above.

Connect the AC/DC adapter to the plug at the back part of the OxyCorder control unit
(3 in Fig. 2) and to the 110-220V AC.

Using the serial port cable, connect the 9-pin connectors to the plug at the back part of
the OxyCorder control unit (2 in Fig. 2) and to either COM1 or COM2 of your

computer.

Using the 2-pin BNC plug mounted to the cables of you electrode, connect it to input

channel (1 - 3 in Fig. 1) with appropriate pre-set impedance.

If you require an additional voltage reading from another instrument (e.g., a
fluorometer), connect the instrument to the input channel 4 of the OxyCorder control

unit (4 in Fig. 1) by the standard BNC cable (optional equipment).

To control function of external device (e.g., a flash lamp), connect it to the TTL output
of the OxyCorder control unit (5 - 7 in Fig. 1) by the standard BNC cable (optional

equipment).

Switch on the instrument (1 in Fig. 2) and the computer and go to the Windows

environment.

Start Menu of Windows operating system to install the software package on your
computer. Click the OxyWin icon to start the program. From the Setup /
Communication menu, select the serial port (COM1 or COM2) to which you have
connected the OxyCorder. Click the Control / Device Id in the menu to activate the
communication. The status info in the lower left corner of the OxyWin window
should appear and the device info in the lower right corner should give you the

instrument name.

4. OXYWIN SOFTWARE

OxyWin software controls polarization voltage of the electrodes, other parameters and

features of the instrument, and displays and helps to analyze the data.
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There are three main windows in the software - Graph, Channel Properties and Description
window that can be seen by selecting them in the View menu (see 4.4.2) or by clicking

appropriate icon of the Page toolbar (see 4.5).

4.1 Graph window

The positions of two cursors in the Graph window (Fig. 3) are indicated by two triangles at
the top of the graph area and by two dashed lines. The cursor can be moved by a mouse click
(left or right). The coordinates of the nearest data points to the left (X1, Y1) and right (X2,
Y2) cursors of the Selected curve are shown for in the bottom left part of the Graph window.
DeltaX and DeltaY define difference between X2 and X1 and between Y2 and Y1,
respectively, while Slope is defined as DeltaY / DeltaX.

/& DxyWin - C:\Progiam Files\PSI\0xywin4D ata\calibr.dat

File “iew Contol Setup Options.. Graph Help
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Fig.3. - The Graph window with a result of the calibration.

4.2 Channel Properties window
The graphical presentation of measured curves can be customized in the Channel Properties
window (Fig. 4) by changing Style, Mark, Mark size, Line style, Line width, Color, and

Brush parameters by double clicking the left mouse button. Any curve can be displayed or
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hidden by a double clicking the left mouse button in Show column. The Caption of each
curve can be modified for easier identification of the objects. Numerical values in each curve
can be multiplied (Multiplication) or shifted along the y-axis (YShift) by double clicking the
left mouse button in the corresponding column. Points give the number of measured data

points in the experiment.

& DxyWin - C:\Program Files\PSI\DxyWin\Data\calibr. dat

File “iew Control Setup Options.. Graph Help

IEEEEr) [EAzAll=Ret]
Show Caption | Style | Mark | Mark size | Line style | Line width | Color | Brush | Points | 'S hift | Multiplication |
2 Yes Ch2 Average m 4 Salid 1 . 123 a 1
Status: | Ready File Size: | 12kB  Date: [9.10.2000 £:52:44 |Found device W-812 , version 20.0.2 v

Fig.4. - The Channel Properties window.

4.3 Description window
In the Description window (Fig. 5) you can give the Title to the experiment and describe the

results.

#E DxyWin - C:\Program Files\PS1\0xyWin\Data\calibr. dat

File “iew Control Setup Optionz... Graph Help
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Title: |testl

Test of calibration.

Date: 7.9.2000

Status: | Rieady File Size: | 12kB  Date: [9.10.2000 £:52:44 |Found device w812, version 20.0.2 4

Fig.5. - The Description window.

4.4 Menu

4.4.1 File menu

The File menu includes following items: New (creates new experiment), Open.. (opens saved
experiment), Save (saves the experiment), Save As.. (saves the experiment as) Export..
(exports the data as text file), Preview (shows the page layout before printing), Print.. (prints
the page), Print Setup.. (setups the printing), Page Setup.. (setups the page layout) and Exit
(exits the OxyWin software).
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4.4.2 View menu
Clicking on the items in the View menu (Graph, Channel Properties, Description) opens
the appropriate software window whereas particular toolbars (Main, Graph, Control, Page,

see 4.5) became visible when selected in the View / Toolbar menu.

4.4.3 Control menu

Clicking on the Monitor item in the Control menu opens a new window where you can see
measured voltage in two selected input channels. Meaning of the Start, Stop and Pause
items of the Control menu is obvious. When the communication port is set in the Setup /
Communication menu, clicking on Device Id item in the Control menu activates the
communication (see 3h). Clicking on the Test 1-st (2-nd, 3-rd) Generator in the Control

menu only tests the signal in the first (second, third) TTL output.

4.4.4 Setup menu

Clicking on the A/D and generators.. item in the Setup menu opens a new window (Fig. 6).

Setup DAC and TTL generators E3
W Abways enabled Bzl
DAA T [m]  DAd 2 [mv) OIff [msz) On [mg) Count
00 ] GO0o00 30000 ] [V Enabled
= s = E Generator 2
OIff [msz) On [mg) Count
i} ] i} ™ Enabled
E_ _lé E E Generatar 3
= = = = Off [msz) On [mg) Count
0 0 0 I~ Enabled
Measure Time(g): Sample Freq. [Hz):
450 il
Senchronization : INone vl [v Beep
E E E E Make average of 9 zamples
= = Ik J (1] I x Lancel | ? Help | ﬁ Generators |

Fig.6 - The Setup DAC and TTL generators.. window.

Using the two vertical scroll bars in the left part of the window, the voltage range for the D/A
converters can be set. By defining parameters of the Generator 1 - 3 in the upper right part
of the window, parameters of the three TTL outputs are set. On [ms] and Off [ms] define for

how long (in milliseconds) there will be a signal on and off, respectively, in the particular
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TTL output. Count defines how many times the signal on and off will be repeated. The
settings of the generators are Enabled by checking the checkboxes. When external devices
for which the generators were defined are connected to the OxyCorder, the setting of the
generators can be checked before the measurement by clicking the Generators button in the
bottom right part of the window. Total Measure Time in seconds is defined in bottom right
part of the window. Sample Frequency only informs you about the rate of data measurement
(in the range of 5 - 30 Hz). The start of the measurement can be synchronized with the timing
of the appropriate generator by its selection in Synchronization. To improve signal / noise
ratio, experimental data points can be averaged (Make average of samples). Checking the

Beep checkbox causes the beep signal when any measurement is performed.

Clicking on the Setup / Scale.. opens a new window (Fig. 7) where voltage scales of the four

input channels are set and a signal from particular input channel is Enabled to be recorded.

Scale
—Ch1 V] —Ch2 [v] —Enabled
0z onz
04 £ 04 u E:;
08 ~ 08 ~
16 15 I~ Ch3
| Auto = Auta [ Chd
[~ Che
~Cha ] ~Chd [V] - Che
0z on2
Ch?
04 04 :: Cha
I ns - na —
16 16 r
* Auto " Auto I"E2
x Cancel | ? Help

Fig.7 - The Scale window.

The Input mode.. and Out ports.. items are not supported by a standard version of the
OxyCorder instrument. By clicking the Setup / Communication, the communication port is
set in the Communication window. Also in this window, checking the Ask device on
startup checkbox automatically enables the communication between the OxyWin software
and the OxyCorder instrument when the software is started (i.e., it is not necessary to click on

the Device Id item in the Control menu).

4.4.5 Options menu
When clicking on the Options.. menu, new window opens where you can check whether you

want to Confirm actions and Print description in printing. By checking the Graph follows
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data checkbox in the menu, the measured curve is displayed online on the screen, otherwise

auto scale functions (from the Graph menu or the particular icon) must be used.

4.4.6 Graph menu

The items in the Graph menu have following meaning: Log Scale X (shows the x-axis in
logarithmic scale), Auto Scale X (autoscales the x-axis), Auto Scale Y (autoscales the y-axis)
and Auto Scale XY (autoscales the x- and y-axes). Clicking on the Manual Scale.. in the
Graph menu opens a new window when you can Set the scale of x- and y-axes manually.
Clicking on the Trim Left (Right) of the Graph menu deletes all the data points on the left
(right) from the left (right) cursor. Fonts used in the graph are set in the window that opens
by clicking on Graph / Font... The fonts can be Saved as default by clicking this item in the

Graph menu.

4.5 Toolbars
There are four toolbars - Main, Graph, Control and Page (Fig. 8) that can be visualized by

selecting them in the View / Toolbar menu.

= DxyWin
File “iew Control Setup Options.. Graph Help

%ﬂf%‘l@al ?C/JHHII@% ole o] |Z0@=

6 % 8
The Main toolbaa The Graph toolbaa @he Control t@ The Page toolbarj

Fig.8 - The toolbars.

The Main toolbar contains following icons: New Experiment (creates new experiment),
Open Experiment (opens saved experiment), Save Experiment (saves the experiment),

Print (prints the page), Print Preview (shows the page layout before printing) and Help.

The Graph toolbar contains following icons: Auto Scale X (autoscales the x-axis), Auto
Scale Y (autoscales the y-axis), Auto Scale XY (autoscales the x- and y-axes) and Undo
(undoes the last action). Clicking the Select Signal icon of the Graph toolbar opens a new
window where you Select Curve, parameters of which are shown below the graph. The
Show All and Hide All icons of the Graph toolbar show all curves in the graph and hide all

curves, respectively.



User’s Guide - page 11

Clicking on the Start, Stop or Pause icons of the Control toolbar starts, stops or makes a

pause, respectively, in the experiment.

The Page toolbar contains the Graph, Channel Properties and Description icons, clicking
of which opens the Graph window, Channel Properties window and Description window,

respectively.
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